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About This Manual  v

ABOUT THIS MANUAL

The SCOPIA Connector for IBM Lotus Sametime Installation Guide provides 
information for administrators about SCOPIA Connector deployment, and 
installation in the IBM Lotus Sametime and IBM Lotus Sametime Web 
Conferencing environment.

Note The SCOPIA Connector plug-in works with the following IBM product 
versions:

� Sametime 7.5
� Sametime 7.5.1
� Sametime 7.5.1 CF1
� Sametime 8.0, 8.0.1, and 8.0.2
� Lotus Notes 8.0

This manual refers to options available in Sametime 8.0. 
Configuration options may vary according to the product version you are using. 

HOW TO USE THIS 
MANUAL

This manual provides information about deploying both SCOPIA Connector for 
Lotus Sametime and for SCOPIA Connector for Lotus Sametime Web 
Conferencing:

� Chapter 1, Installing the SCOPIA Connector Plug-in for Lotus 
Sametime on page 1

� Chapter 2, Integrating SCOPIA Connector for Lotus Sametime Web 
Conferencing into the Sametime Deployment on page 9



FEEDBACK The team at RADVISION constantly endeavors to provide accurate and 
informative documentation. If you have comments or suggestions regarding 
improvements to future publications, we would value your feedback.
Please send your comments to doc_comments@radvision.com.
We thank you for your contribution.
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1
INSTALLING THE SCOPIA CONNECTOR 
PLUG-IN FOR LOTUS SAMETIME

This section describes how administrators can automatically deploy the 
SCOPIA Connector plug-in throughout a network, and how end users can 
manually install the plug-in on a Sametime Connect client.

� About Update Sites on page 1
� Installing the SCOPIA Connector Update Site from the CD-ROM on 

page 2
� Installing the SCOPIA Connector from an Update Site on page 3
� About Distribution Methods for the SCOPIA Connector on page 8

ABOUT UPDATE 
SITES

An update site is a specific directory layout with an XML file that specifies all 
the available plug-ins. The method of how the update site is presented to the 
client can vary (for example, as a web site or via the local file system).
If SCOPIA Desktop is detected when installing SCOPIA Connector, an Eclipse 
update site is created for you in the SCOPIA Desktop installation directory at   
<installdir>/Tomcat/webapps/ROOT/sametime. You can use the update 
site at this location, or you can copy the files from the update site to a location of 
your choice.
We recommend using the installer to create the update site. This is usually set up 
on the same server as SCOPIA Desktop.
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Installing the SCOPIA Connector Update Site from the CD-ROM

If you already have plug-ins that you automatically push via an update site, you 
need to merge the SCOPIA Connector site.xml file with the existing site.xml 
file, and copy the contents of the SCOPIA Connector features and plug-ins 
folders into the existing corresponding folders.

INSTALLING THE 
SCOPIA 
CONNECTOR 
UPDATE SITE FROM 
THE CD-ROM

Install the SCOPIA Connector update site from the SCOPIA Desktop 
CD-ROM.

 ) Procedure

1 Insert the CD-ROM.
2 Wait for the autorun menu screen to display.
3 Click SCOPIA Connector for IBM Lotus Sametime.
4 Select Install Update Site.
5 Click the setup.exe file and follow the on-screen instructions.

The Choose Installation Location screen detects if SCOPIA Desktop is 
installed.

6 If SCOPIA Desktop is detected, the installer attempts to create 
an update site at 
<installdir>/Tomcat/webapps/ROOT/sametime

The default update site URL is http://<server>/sametime.
Where <server> stands for either the IP address or FQDN of the server 
on which you install the SCOPIA Connector.

7 Alternatively, you can instruct the installer to create an update 
site at a different location.
These necessary files must either be placed under a Sametime update site 
or should be distributed manually.
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Installing the SCOPIA Connector from an Update Site

8 If SCOPIA Desktop is not detected, define the location at 
which you want the installer to place the files needed for an 
update site.
By default, the installer places the files at
\Program Files\Radvision\SCOPIA Connector for IBM 
Lotus Sametime

You must either place the files needed for an update site under a 
Sametime update site, or distribute them manually.

INSTALLING THE 
SCOPIA 
CONNECTOR FROM 
AN UPDATE SITE

� How to Automatically Deploy the SCOPIA Connector on page 3
� Manually Installing the SCOPIA Connector from an Update Site on 

page 5

HOW TO 
AUTOMATICALLY 
DEPLOY THE SCOPIA 
CONNECTOR

� Installing the SCOPIA Connector via the Community Client 
Document (for Administrators) on page 3

� Installing the Plug-in via the preferences.ini File (for End Users) on 
page 4

INSTALLING THE SCOPIA 
CONNECTOR VIA THE 
COMMUNITY CLIENT 
DOCUMENT (FOR 
ADMINISTRATORS)

This section describes how you can automatically deploy the SCOPIA 
Connector plug-in via the Sametime server Community Client Document.

 ) Procedure

1 Create an update site (see Installing the SCOPIA Connector 
from an Update Site for an explanation of update sites).

2 Open the stconfig.nsf file on the Sametime server. 
3 Double click the CommunityClient document.
4 Add the full path to your update site (including http://) in the 

URL for UIM Provisioning field.
5 Copy this URL to the Sametime update site URL field in the 

Policy which applies to the users.
6 Save and close the stconfig.nsf file.
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Installing the SCOPIA Connector from an Update Site

7 Using the web-based server administrator 
(http://<server>/stcenter.nsf) log in as the administrator.
Where <server> stands for either the IP address or FQDN of the 
Sametime Server.

8 Click the Administer the server link.
9 Click the Policies link.
10 Click the Sametime Default Policy link.
11 In the Instant Messaging section, modify the Sametime update 

site URL with local update site on the Sametime server.
12 Click Go to save your changes.
13 Use another web page and run the Domino Server 

Administrator (http://<server>/webadmin.nsf).
14 Log in and click the Server tab at the top of the page.
15 Select Tools > Server > Restart to restart your Sametime 

server. 
The next time a user logs in to the Sametime Connect client, the plug-in 
is downloaded and the user is prompted to restart the Sametime client.

INSTALLING THE PLUG-IN 
VIA THE PREFERENCES.INI 
FILE (FOR END USERS)

This section describes how you can automatically deploy the SCOPIA 
Connector plug-in via the Sametime Connect preferences.ini configuration file.
The preferences.ini file is located by default at the following locations on the 
Sametime Connect client:

� Sametime 7.5.x
C:\Program Files\ibm\Sametime Connect\plugins\

com.ibm.collaboration.realtime.update_1.0.0

� Sametime 8.0
C:\Program Files\IBM\Lotus\Sametime Connect\shared\

eclipse\plugins\com.ibm.collaboration.realtime.update
_8.0.0.20071119-1552

 ) Procedure

1 Create an update site (see Installing the SCOPIA Connector 
from an Update Site on page 3 for an explanation of update 
sites).

2 Open the preferences.ini file. 
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Installing the SCOPIA Connector from an Update Site

3 Type your update site URL as the value for the 
adminUpdatePolicyURL parameter. Use the format
adminUpdatePolicyURL=http://server.domain.com/

directoryname/site.xmls

4 Save and close the preferences.ini file.
The next time the user logs in to the Sametime Connect client, the client 
searches for the update site URL in the URL for UIM Provisioning 
parameter of the stconfig.nsf file on the Sametime server.
If the client fails to find the URL, the client searches for the value of the 
adminUpdatePolicyURL parameter of the preferences.ini file.
When the client finds this value, the plug-in is downloaded and the user 
is prompted to restart the Sametime client.

MANUALLY INSTALLING 
THE SCOPIA 
CONNECTOR FROM AN 
UPDATE SITE

This section describes how Sametime end users can manually install the 
SCOPIA Connector plug-in on a Sametime Connect client.
The SCOPIA Connector plug-in is available for download from an update site. 
For more information, see Installing the SCOPIA Connector from an Update 
Site on page 3.

Note Sametime Administrators may prevent end users from performing manual 
downloads. For more information, see Preventing Manual Downloading on 
page 6. 

 ) Procedure

1 In the Sametime Connect client user interface, choose 
� (for Sametime 7.5 CF1) File > Manage Updates > 

Download Plugins 
� (for Sametime 7.5.1 and 8.0) Tools > Plug-ins > 

Install plug-ins.
2 If you have a previous version of the plug-in already installed, 

the installer prompts you to search for updates to the currently 
installed features. In the Feature Updates window, choose 
Search for updates of the currently installed features, and 
then go to step 9.
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Installing the SCOPIA Connector from an Update Site

3 If you do not have a previous version of the plug-in installed, 
in the Feature Updates window choose Search for new 
features to install, and click Next.

4 In the Update sites to visit window, click Add Remote 
Location (or New Remote Site for Sametime 7.5.1 CF1).

5 Type an update site name and URL.
For example, name “SCOPIA Connector” and URL 
http://<server>/sametime.
Where <server> stands for either the IP address or FQDN of the server 
hosting the update site.

6 Click OK to save the location.
7 Click the checkbox for the new location.
8 Click Finish.
9 In the Search Results window, expand the tree labeled with the 

name that you typed at step 5 to view all available SCOPIA 
Connector plug-ins.

10 Choose the latest version of the SCOPIA Connector plug-in 
and click Next.

11 In the Feature License window, accept the terms of the license 
agreement and click Next.

12 In the Installation window, click Finish.
13 Click Install or Install All.

If the installation is successful, you are prompted to restart the Sametime 
client to access to the new plug-ins.
Installation is now complete and the SCOPIA Connector plug-in 
Preferences window is now available.

PREVENTING MANUAL 
DOWNLOADING

This section describes how Sametime administrators can prevent end users from 
performing manual downloads to a Sametime Connect client.

 ) Procedure

1 On the Sametime server host machine, open the sametime.ini 
configuration file located at \Lotus\Domino. 

2 Under the [config] section, add the following line: 
DisableConnectPluginUpdates=1. 
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Installing the SCOPIA Connector from an Update Site

3 Restart the server and reconnect with the client. 
The user options are grayed out.
In the Sametime Connect client user interface, the options under Tools > 
Plug-ins are disabled.

INSTALLING THE 
SCOPIA CONNECTOR 
WITHOUT AN HTTP 
SERVER

This section describes how to install the SCOPIA Connector plug-in in 
Sametime Connect client from a local file without using an HTTP server. To do 
this, you locate the update site in a shared network directory. Users can then 
access this directory from the Sametime Client interface.

 ) Procedure

1 Save the sametime directory to a shared network location.
2 In the Sametime Connect client user interface, choose Tools > 

Plug-ins > Install plug-ins.
3 In the Feature Updates window choose Search for new 

features to install, and click Next.
4 In the Update sites to visit window, click Add Folder 

Location (for Sametime 8.0) or New Local Site (for Sametime 
7.5.1), navigate to the saved sametime directory and click OK.

5 Click Finish. The Sametime Connect client now searches for 
updates from the defined site.

6 In the Search Results window, select sametime. 
7 Type a new name for the directory and click OK, or leave the 

directory name unchanged.
8 Click Next.
9 In the Feature License window, accept the terms of the license 

agreement and click Next.
10 In the Installation window, click Finish.
11 Click Install or Install All.

If the installation is successful, you are prompted to restart the Sametime 
client to access to the new plug-ins.
Installation is now complete and the SCOPIA Connector plug-in 
Preferences window is now available.
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About Distribution Methods for the SCOPIA Connector

ABOUT 
DISTRIBUTION 
METHODS FOR THE 
SCOPIA 
CONNECTOR

You can distribute the SCOPIA Connector plug-in by using these methods: 
� “Pushing” the plug-in to all Lotus Sametime Connect users in a 

specified community.
The plug-in is automatically downloaded to the client when the user 
launches Lotus Sametime Connect. The user is notified of the update and 
can have the client restart automatically to load the new plug-in.
For more information, see How to Automatically Deploy the SCOPIA 
Connector on page 3.

� Sending the update site URL to users.
Users must then retrieve and install the plug-in manually using the Lotus 
Sametime Connect Manage Updates user interface.
For more information, see Manually Installing the SCOPIA Connector 
from an Update Site on page 5.
You can optionally prevent users from performing this procedure. For 
more information, see Preventing Manual Downloading on page 6.
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2
INTEGRATING SCOPIA CONNECTOR 
FOR LOTUS SAMETIME WEB 
CONFERENCING INTO THE SAMETIME 
DEPLOYMENT

� Planning to Deploy IBM Lotus Sametime Web Conferencing with 
SCOPIA Connector Deployment on page 9

� Installing the Sametime Connector on the SCOPIA Desktop Server 
on page 13

� Preparing the Sametime Servers on page 13
� Configuring the Sametime Settings on the SCOPIA Desktop Server 

on page 14

PLANNING TO 
DEPLOY IBM 
LOTUS SAMETIME 
WEB 
CONFERENCING 
WITH SCOPIA 
CONNECTOR 
DEPLOYMENT

When you integrate IBM Lotus Sametime with SCOPIA Desktop, your users 
can add real time multipoint video and audio to Sametime Web meetings. In 
order to accomplish this, you must associate a SCOPIA Desktop Server with an 
IBM Lotus Sametime Community deployment.
You use two modules for the integration:

� Sametime Connector, a Sametime Community Server application 
that runs as part of the SCOPIA Desktop Middleware

� Sametime Meeting Room Client Javascript extension that is used to 
realize the user interface inside the Sametime Meeting Room Client
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Planning to Deploy IBM Lotus Sametime Web Conferencing with SCOPIA Connector Deployment

Sametime Connector detects the start of a Sametime meeting and attaches 
meeting attributes along with an ID of a SCOPIA Desktop ad-hoc meeting 
which is generated at that time. The Javascript extension is loaded with the 
Meeting Room Client when a user joins a Sametime meeting and pulls the video 
meeting information from the meeting so that all attendees transparently join the 
same video meeting.
Read these sections to correctly plan your deployment:

� Simple Sametime Deployments on page 10
� Multiple Sametime Community Hubs Deployments on page 11

SIMPLE SAMETIME 
DEPLOYMENTS

Use this diagram when planning your Sametime Deployment.

Figure 2-1 Simple Sametime Deployment
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Planning to Deploy IBM Lotus Sametime Web Conferencing with SCOPIA Connector Deployment

MULTIPLE SAMETIME 
COMMUNITY HUBS 
DEPLOYMENTS

In deployments described in this section, there may be multiple community 
hubs. Users schedule meetings through their home Sametime Server and may 
invite users from the same home server as well as users from other Community 
Server clusters. The meetings may be hosted on the home Sametime Server of 
the meeting creator as shown on Figure 2-2. In this case, meeting attributes do 
not need to be propagated to the other server. 

Figure 2-2 Multiple Sametime Community Hub Deployment for 
non-propagated meetings
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Planning to Deploy IBM Lotus Sametime Web Conferencing with SCOPIA Connector Deployment

Alternatively, meetings may be hosted on different Sametime Servers. In this 
case, the meeting information and attributes are propagated from the home 
Sametime Server to the other server as shown on Figure 2-3 on page 12.

Figure 2-3 Multiple Sametime Community Hub Deployment for 
propagated meetings
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Installing the Sametime Connector on the SCOPIA Desktop Server

INSTALLING THE 
SAMETIME 
CONNECTOR ON 
THE 
SCOPIA DESKTOP 
SERVER

 ) Procedure

1 Install SCOPIA Desktop Server.
2 On the SCOPIA Desktop Server, navigate to this location: 

>InstallDir>SCOPIA Desktop\SametimeWeb.
3 Double-click the enable_sametime.vbs file.
4 Click OK in the confirmation message.

When the installation is completed, a message is displayed 
explaining that the Sametime Connector is installed and the log 
file is created.

PREPARING THE 
SAMETIME 
SERVERS

� Enabling Community Services Connectivity on page 13
� Installing the Meeting Room Client Javascript Extension on page 14

ENABLING COMMUNITY 
SERVICES 
CONNECTIVITY

To prepare the Sametime server for the SCOPIA Connector for IBM Lotus 
Sametime Web Conferencing, you must edit the Sametime configuration: open 
the IBM Domino Administrator Application and change the IP address 
configuration of the SCOPIA Desktop Server to allow connection to 
Community Services. Perform this procedure on every Sametime server which 
has a SCOPIA Desktop Server associated with it.

 ) Procedure

1 Open the IBM Domino Administrator application.
2 Click the Domain tab.
3 Click the Files tab.
4 Navigate to this location: \Program Files\IBM\Lotus\Domino\Data.
5 Double-click the Sametime Configuration file.
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Configuring the Sametime Settings on the SCOPIA Desktop Server

6 Click By Form in the left pane.
7 Right-click the CommunityConnectivity, and then select Edit.

The form opens.
8 Enter the IP address of the SCOPIA Desktop Server in the Community 

Trusted IPS field.
9 Click File > Save.

INSTALLING THE 
MEETING ROOM 
CLIENT JAVASCRIPT 
EXTENSION

In order to enable the video integration, you need to copy a file to the Sametime 
server. This file was placed on the SCOPIA Desktop Server during the SCOPIA 
Connector installation.

 ) Procedure

1 On the SCOPIA Desktop Server, navigate to this location:
Program Files\Radvision\SCOPIA Desktop\SametimeWeb\

2 Copy the SDMrcExtension.js file.
3 On the Sametime server, navigate to this location:

\Program 
Files\Lotus\Domino\data\domino\html\sametime\jsext

4 Paste the copied file into this location.

CONFIGURING THE 
SAMETIME 
SETTINGS ON THE 
SCOPIA DESKTOP 
SERVER

You need to configure the SCOPIA Desktop Server to work with the Sametime 
Server.

Before You Begin

� Access the SCOPIA Desktop Administration web user interface.
� Verify the Sametime Server address.
� Verify which port on the Sametime Server you need to assign to the 

SCOPIA Desktop Server.

 ) Procedure

1 Click Sametime in the sidebar.
2 Enter the Sametime Server address.
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Configuring the Sametime Settings on the SCOPIA Desktop Server

3 Enter the port on the Sametime Server.
The default port is 1516.

4 Enter the meeting prefix for the SCOPIA Desktop Server to use for the 
Sametime meetings.

5 If necessary, set the number of video panes displayed in the Conference 
Client pane when it is opened in the Sametime Meeting Room window:
a Select Set the initial view that users will see when 

they join a Sametime meeting.
b Click one of these options:

� 1 Video
� 2 Videos

6 If necessary, select Enable Audio in SCOPIA Desktop for Sametime 
meetings.

7 If necessary, select Allow only the Sametime Meeting Chair to add 
video to a meeting. This allows a Sametime Meeting chair to control 
when the video pane is displayed in the user's meeting room client.

Note This feature in not available if the SCOPIA Connector is configured to 
work with the Sametime Server version 7.5.1.

8 If necessary, select Allow only the Sametime Meeting Chair to 
moderate a meeting. This determines whether audio and video 
moderation functions are enabled only a Sametime Meeting chair or for 
all participants in a SCOPIA Desktop meeting.

9 Click OK or Apply.
10 Verify that the connection to the Sametime Server is successful:

a Click Status in the sidebar.
b Click the link showing the IP address of the Sametime 

Server to display the settings.
The indicator next to the link shows whether or not the 
connection to the Sametime server is successful. When the 
indicator is red, a tooltip containing error details is 
available. Click the red indicator to view further error 
information.
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Configuring the Sametime Settings on the SCOPIA Desktop Server
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